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Welcome

Welcome to the Microsoft® Producer for PowerPoint® 2002 evaluation guide.

Microsoft Producer for PowerPoint version 2002 is an add-on tool to PowerPoint in Office XP.  Built using Windows Media Technologies, it’s designed to address the growing need among businesses and organizations using streaming media to have easy ways to create dynamic internal and external streaming media communications. 

The Rapid Growth of Streaming Media in Large Organizations 

Streaming audio and video is not just a consumer phenomenon. Over the past few years, large enterprise organizations have begun to embrace the use of digital media as a way to more effectively communicate throughout their companies.

In March 2001, Jupiter Media Metrix predicted that corporations will spend dramatically higher amounts on streaming video technology over the next four years, estimating spending would grow from 
$140 million last year to $2.8 billion in 2005.
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In April 2001, a new study of more than 700 large organizations conducted by Market Decisions Corp. revealed that one in four large organizations in the United States are now using streaming media to communicate within their organizations. Streaming media usage has effectively doubled in the past 18 months. This research also found that two-thirds of these companies continue to use Microsoft® Windows Media™ Technologies as their technology of choice. 

Whether it is an important CEO address streamed to thousands of employees simultaneously or an on-demand training course users can stream to the PC when it fits their schedule, companies are embracing streaming media at a rapid rate.

Streaming media is rapidly becoming a mainstream technology for improving the effectiveness of training and internal and external communications, while achieving significant cost savings on travel and facilities costs, as well as swifter information sharing throughout an organization. 

However, as companies are discovering these benefits, one of the key challenges they face is how to overcome the complexity and specialized knowledge needed to combine and synchronize audio and video content with PowerPoint slides, images, and HTML — otherwise known as “rich media” — and put it in the hands of many more workers. Until today, creating rich-media presentations required a lot of specialized knowledge, HTML coding skills, and the ability to juggle multiple types of software to get the results companies want. 

Microsoft Producer for PowerPoint version 2002 is a unique new tool – the first of its kind - that breaks down these barriers for content creation by enabling both business users of PowerPoint and sophisticated media professionals to quickly and easily create rich media presentations. 

Executive Overview

Microsoft Producer for PowerPoint 2002
Enables New Ways to Communicate and Share Information

Just as the FrontPage® Web site creation and management tool helped simplify and automate for the Office user the creation of Web sites using HTML, Microsoft Producer makes it easy for any PowerPoint user or enterprise media professional to create engaging and effective rich-media presentations. 

Microsoft Producer enables users to capture and synchronize audio, video, slides and other elements, and publish this rich-media presentation virtually anywhere. These presentations can then be viewed on demand via a browser on a desktop PC across an intranet or the Internet, as when a company meeting is recorded and then viewed, complete with synchronized slides, on demand by anyone who wants to.

Microsoft Producer can be installed on both Windows® 2000 and Windows XP operating systems, and requires the installation of Office XP. Presentations created with Producer can be viewed by any PC equipped with Internet Explorer browser software (version 5.0 or higher). 

Features at a Glance

Capture, import and organize audio, video, slides and HTML
· Import many audio and video formats 

· Integrated live capture 

· Easily organize video clips 

· Superior audio and video quality 

· Automated PowerPoint slide conversion 

· Quickly import images and HTML 

· Directly edit PowerPoint slides 

· Supports PowerPoint version 2002 animations 

Easily synchronize media into customizable 
rich-media presentations

· Use PowerPoint rehearsal timings 

· Synchronize rich media 

· Robust video effects and transitions 
· Lay out Web pages with one click 

· Easily customize templates 

· Change layouts “on-the-fly” 

· Automatically generate Table of Contents entries 

· Easily manipulate Table of Contents entries 

Publish and share streaming presentations anywhere

· Preview before publishing 

· Simple sharing 

· Advanced publishing capabilities 

· Easily move projects with “Pack & Go” feature 

· FrontPage integration 

· Publishing SDK simplifies solution integration 

Usage Scenarios

The following are examples of how rich-media presentations created with Producer can be used in business to do the following: 
· Create cost-effective training delivered any time and on any desktop

· Create high-impact, engaging rich media business presentations

· Create sales and marketing communications with impact

· Deliver on-demand executive broadcasts companywide or to small groups

· Enable better access to existing video libraries within an organization by enabling easy indexing and publishing to intranet Web sites

Creating Cost-Effective Training Delivered Any Time, on Any Desktop PC
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Rebecca, a training manager, uses Microsoft Producer to create content that her customers access when they want, where they want and at their own pace. 

· She uses Microsoft Producer to create intranet-based training curricula that deliver video and training content from PowerPoint right to employees’ desktops through their browsers.
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Employees can quickly find and view specific sections of content by clicking on the Table of Contents entries that were automatically created when Rebecca imported her slides into Producer. This is easier and more time-effective than searching through video tapes. 

Barbara is in charge of human resources and HR training in a large multinational company. Like many managers today, Barbara is looking for ways to reduce corporate expenses. Barbara uses Microsoft Producer to reduce by thousands of dollars the amount the company spends weekly to train new hires.

· Currently, the company incurs steep costs associated with delivering its frequently held New Employee Orientation program. Expenses include travel, facilities and refreshments, as well as time out of the office for both employees and presenters. 

· Barbara saw how the intranet could make a huge impact. She gathered all the slides, videos and images used by the speakers, videotaped them giving their presentations, and brought it all into Producer to create a Web-based training seminar. 

· Now new employees are sent an e-mail message with a link to the New Employee Orientation Web site, and they can view the content at their convenience with their desktop PC and a browser. 

A More Effective Presentation Tool for Business Users
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Marla, the financial analyst for a large manufacturing company, is using Microsoft Producer to more effectively communicate key quarterly financial results and analysis within her organization. 

· Microsoft Producer gives Marla easy-to-use wizards to quickly combine her PowerPoint slides and images with an audio recording of her analysis on the outlook for key product lines in the company.

· Marla’s critical knowledge behind the bullet points and graphics can now be shared throughout the company without the time consuming process of writing specific notes on slides. 
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This information will continue to live throughout the company; it is always available for on-demand viewing by her busy employees on their intranet. 

Creating Effective Sales and Marketing Communication

Rob owns a landscaping company and is using Producer to ensure that his Web site better communicates his enthusiasm and charisma, as well as showcases his past work. Producer helps Rob go beyond photo albums on the Web. 

· Rob now records himself giving his sales presentation in his own words on video, combines it with the high-quality photographs and video he has of previous landscaping jobs and with links from his existing Web site, and synchronizes these elements with a PowerPoint slide presentation, communicating his company’s services, products and pricing. 

· He is able to publish this rich-media presentation to his Web site using Producer’s Publish Wizard.

Delivering Executive Broadcasts
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Brian works in his company’s media department, and has been tasked with getting his CEO’s monthly address posted to the intranet.

· Brian makes sure that the CEO has Producer’s PowerPoint plug-in to automatically record each “slide flip.”
· After the CEO delivers his PowerPoint presentation, Brian saves the PowerPoint file and imports it into Producer. He also imports the audio and video that was captured with a digital camera.
· Finally, Brian places both the slides (including the recorded slide flips) and the audio/video file onto Producer’s timeline, selects a layout for the presentation, and publishes to the corporate intranet.
[image: image8.emf] 

Easy Indexing and Publishing of Existing Video Libraries to an Intranet Web Site

Alex, the videotape librarian at his company, has found that many people find it takes too much time to find the information they are looking for on videotapes. 

· He discovered that Microsoft Producer gives him an effective, low-cost means of making the library of video content available to all employees via their intranet. 

· By importing the videos using Producer’s Capture Wizard and using Producer’s Clip Detection feature, the video is split into multiple, quickly accessible clips. 

· Alex can then add Table of Contents entries at appropriate points in the video. Employees are also able to quickly find and view specific sections of the content, rather than traditional means of searching through video tapes.

Guide to Producer Features

Capture, import, and organize audio, video, slides and HTML 

Note: The following files are required to complete the “Try-It” sections. These files are contained inside a self-extracting zip file.  You can find this zip file at http://www.microsoft.com/office/powerpoint/producer/evalguide.htm 

· Int_Train.ppt

· Int_train_begin.wmv

· Int_train_end.wmv

· Sample_Interview.wmv

· status_report.ppt
It is also recommended that the timeline be cleared out before starting each new “Try-It” by removing any media types you may have previous inserted.

Importing Existing Video and Audio
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Existing video and audio can be imported into a rich-media presentation to give it more impact. Using the Import command, users can import a wide range of video formats such as Windows Media Format, AVI and MPEG (.m1v, .mp2, .mp2v, .mpa, .mpe, .mpeg or .mpv2). Similarly, many audio types are supported including Windows Media Format, MP3 and WAVs. Media can then be placed in the timeline where items can be manipulated and synchronized to create a professional look. 

Try it for yourself!

Using the media included in “eval_guide_try-it_files.zip”,, you can quickly see how effective and easy it is to integrate multiple media types into a clear, concise presentation format. 
Using the “New Presentation Wizard,” simply follow these steps to create your first rich-media presentation:

1. Select “New Presentation Wizard…” from the File menu.

2. Click on Next after you’ve read the introduction screen.

3. Choose a template: Select one of the many templates based on the media you have at hand. If you’re not sure, simply use the default template and click on Next to continue.

4. Choose the presentation scheme: Change any of the fonts, sizes, colors or other elements to be used or just click on Next to accept the defaults.

5. Specify presentation information: Producer creates a Pre-roll page, the first page viewed by the audience, which includes a title, cover page image, the presenter’s name and a description that gives the audience an overview of the presentation. Complete these fields, or simply click on Next to accept all defaults and continue.

6. Import Slides and/or Images: Using the Browse button, select the PowerPoint file called “Int_Train.” 

7. Import or Capture Video and Audio: Import existing video by clicking on Browse and choosing the “Int_train_begin” Windows Media video file. Alternatively, you can create audio or video for your presentation by either importing or capturing it. You can capture audio or video from any connected DirectShow®-supported capture device by clicking on the Capture button.

8. Synchronize: The last step in the process is to indicate that you want to synchronize the imported video and slides. Click on the Yes radio button and then Next. 
Note: If you wish to capture a new audio or video file and synchronize it with slides, please use the Capture Wizard.

9. Click on Finish and Producer will import all the elements you’ve specified and launch the Synchronize Wizard.

10. To synchronize it all, you will now see a slide window accompanied by a video preview window. To begin, click on the Play icon to start the video. At the appropriate times, click on the Next Slide button to change to the next slide. Once you’re done, click on Finish.

Video and Audio Capture

Producer makes the process of creating new video and audio simple and straightforward with the Capture Wizard. Using any DirectShow-supported devices such as digital and analog camcorders, VCRs, web cameras and other devices, video content can be captured for use in your presentation. If you are using Windows XP, you can also take full advantage of its new AutoPlay feature that automatically appears when any OHCI-compliant 1394 camcorder is plugged in. 
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Producer uses the Windows Media audio and video 8 codecs for the creation of high-quality, highly compressed audio and video files for use in the presentations. Windows Media Video 8 offers the best quality audio and video in the smallest file size, achieving near-VHS quality video at 250 Kbps and CD-quality audio at 64 Kbps — half the rate of an equivalent-quality MP3 audio file. 

Audio and video content can be created using the Capture Wizard or as part of the New Presentation Wizard. Producer also includes profiles that provide the user with multiple options for encoding bit rates.

Try it!

1. Using the Capture Wizard, capture some audio to narrate slides. Start by using the PowerPoint file named “status_report.”

2. Import the slides into Producer and drag them onto the timeline.

3. To start the capture process you must have a microphone connected to your computer. Click on the Capture button in the Toolbar to begin.

4. The Capture Wizard will appear, presenting seven capture options. Select “Narrate Slides With Audio,” then click on Next.

5. Specify the audio capture setting (typical setting is fine), then click on Next.

6. The next screen allows you to specify the sources for capturing the audio. Make sure the microphone you are using is selected. When you’ve confirmed that the correct audio source is selected, click on Next.

7. Now, click on Capture to begin, and the Next Slide button to advance the slides as you speak.

8. Click on Finish once you are done capturing the audio, then click on Save to save it in the desired location.

9. The audio file you just saved will now appear as an available Audio resource (or Video, had you captured video and audio using a digital camcorder) to your project, and will be placed into the timeline in the appropriate places, synchronized with the slides. Producer will automatically switch to the Preview Presentation tab to allow you to view your presentation.

Editing and Clip Detection
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All video files, either imported or captured by Producer, can be split into smaller video clips based on automatic shot detection. 

This feature makes it quick and easy to access a specific scene within a long clip, as well as to edit and synchronize content. Splitting the video into smaller clips that are then placed in the timeline also facilitates the use of transitions and video effects. Video editing can also be performed within Producer by setting In and Out points and creating specific clips as a result.

Try it!
To automatically split a video into smaller clips, do the following:
1. Import existing video by clicking on Browse, and browsing to the “Sample_Interview” Windows Media video file.

2. Right-click on the Sample_Interview icon or thumbnail in the video window.

3. Select the Clip Detection command. This will split the video into multiple clips, making it easier to find specific content and manage large video. 

4. The resulting clips will appear as several individual icons or thumbnails that can be individually placed in the timeline. Transitions can be added between clips, and this will also allow users to access specific pieces of the video clip more quickly. 

Superior Audio and Video Quality With Windows Media Audio and Video 8 Codec Technology

Users can easily capture new audio and video content or import existing audio and video files, taking full advantage of the stunning audio and video quality of Windows Media Audio and Video 8. The Capture Wizard allows for the selection of the quality and file size settings that best meet users’ needs and those of their audience.

Import Slides, Images and HTML

Producer allows users to import slides directly from PowerPoint version 2002 files, automatically reads the slide titles to create Table of Contents entries, and automatically converts the slides to HTML. Producer supports importing slides from previous versions of PowerPoint by creating HTML files from the slides instead of JPEG images. Producer also maintains the compelling animations and transitions available with PowerPoint version 2002. Users can also import image files and HTML pages to create even richer synchronized presentations.

Try it!
Adding images, slides and HTML to your presentation are all done in a similar manner.

To add these elements, simply do the following:
1. Double-click on the Slides icon.

2. You will then see an Import icon appear in the Slides area of the application. Double-click on the Import icon and, using the dialog box, browse to the “Int_Train” PowerPoint file.
This can also be done by selecting the Import command from the file menu and performing the same steps as above.

PowerPoint Integration

Producer gives users seamless integration with PowerPoint version 2002. Users can easily revise slides right inside Producer itself. When a user double-clicks on a given slide, Producer will automatically open PowerPoint version 2002, allow the user to edit and then save changes directly in PowerPoint. Once the desired edits are made in PowerPoint, Producer will automatically save the revised PowerPoint file and import the updated slides into the Producer project. This is especially useful for making last-minute changes to slides that have already been imported. Because Producer converts slides to HTML, it can maintain the compelling animations and effects that can be used in PowerPoint version 2002. 

Producer also ships with a plug-in to PowerPoint. This plug-in allows  presenters to deliver their PowerPoint presentation and automatically record each “slide flip.” Producer will automatically recognize these slide flips when the PowerPoint file is imported.

Easily synchronize media elements into customizable, rich-media presentations

Synchronization
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Using Producer’s Synchronize Wizard, users can synchronize the images, slides and HTML pages that are displayed with the video and audio tracks. This is an especially powerful feature when synchronizing presenters’ video and audio with the slides, images and HTML pages they are referencing. Synchronization can take place in real time during audio and video capture, or after video, audio and slides have been imported or captured into the project. Producer will automatically make adjustments in the timeline to ensure that the timing of all media is coordinated.

Try it!

1. Once you have imported the Interview Training videos (“Int_train_begin”, “Int_train-end”, “Sample_Interview”) and slides (“Int_Train”), and placed them on the timeline, click on Synchronize to start synchronizing. 

2. You will now see a slide window accompanied by a video preview window. To begin, click on the Play icon to start the video. At the appropriate times, click on the Next Slide button to change to the next slide. Once you’re done, click on Finish. The slides will be updated with the new timings based on your input in the Wizard.
Video Effects and Transitions
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To further increase the effectiveness of the video included in a presentation, Producer offers many video effects and transitions. These effects, such as “fade in” and “fade out,” can be easily added using a drag-and-drop interface, making it easy to use them to enhance presentations. A wide assortment of video transitions can also be added to enhance the transition from one video clip to another by means of a similar drag-and-drop method. More than 40 transition effects come with Producer, giving users a wide range of video effects to customize their presentations.

Try it!
To implement a Video Effect, use the sample videos named “Int_train_begin,” “Sample_Interview,” and “Int_train_end.”

1. To choose an effect, select Video Effects from the Tools menu. You will then see sample frames with the names of the effects .

2. To preview an effect, click on the effect frame to select it, and click on the Play button to the right to preview it.

3. Once you’ve selected an effect, click on it and drag it down to the timeline, onto the video clip of choice (for instance, “Int_train_begin.”)

4. A paint can icon will then appear on the clip, indicating that one or more effects has been chosen for that clip. 

5. You can right-click on the paint can icon and choose Effects to manage multiple effects on a single clip by prioritizing the order in which the effects are implemented.

6. Effects can also be removed in the same manner.

Try it!
To implement a transition, you must have two or more clips in your timeline.

1. Using the sample videos, import the “Int_train_begin” and “Sample_Interview” files and place them on the timeline.

2. To choose an effect, select Video Transitions from the Tools menu. You will then see sample frames with the names of the transitions.

3. [image: image14.jpg]


To preview a transition, click on the transition frame to select it, and then click on the Play button to the right to preview it.

4. Once you’ve selected a transition, click on it and drag it in between the clips of choice. 

5. The transition effect will now appear in the transition area of the timeline for further fine-tuning of the effect.

Templates
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Producer also offers the capability to change Web page layouts (called templates) during the course of a presentation, providing a richer and more engaging user experience. With dozens of templates to choose from, content creators can increase the effectiveness of the media being presented by highlighting key elements by using different layouts at appropriate times. Web developers with knowledge of Cascading Style Sheets (CSS) can also create their own customized templates for use in their presentations, or modify those provided. 

Try it!

1. After you have imported the Interview Training video and slides (“Int_train_begin,” “Sample_Interview,” “Int_train_end” and “Int_Train”) and placed them in the timeline, choose Presentation Templates from the Tools menu. You will see a series of sample templates to choose from in the center of the screen.
2. To choose the template for your entire presentation, or just part of it, click on and drag the template you want into the Template area of the Timeline. Since you have video and slides in your timeline, choosing the “Clouds Video (240x180)-Fixed Slides and HTML” template would be suitable.

3. To adjust the template’s duration, you can click on the end of the horizontal bar in the Template timeline area and drag it to adjust the beginning and end points for the template. 

4. You can now choose another template to implement a template change. Choose another suitable one, such as, “Organizational Video (240x180)-Resizable Slides and HTML,” and add it to the timeline, to the right of the first template. 

5. You can now click on the “Preview Presentation” tab to preview the template change.
Presentation Customization and the Introduction Page

In addition to all the customization features already described, presentations can be further refined by choosing different fonts, font sizes and background colors. This can be done through the New Presentation Wizard, or by selecting Edit/Presentation Scheme from the drop down menu. The Pre-Roll page — the first page the audience will see — can also be customized with a title, image, presenter name and description of the presentation.

Automatically Generate the Table of Contents

Producer automatically generates a Table of Contents from the slide titles and image file names, making it easy for users to jump to different places in the presentation. The Table of Contents entries can also be edited after they have been generated via the Table of Contents tab for easy customization by the presentation author.

Publish and Share Presentations Anywhere

Previewing a Presentation
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Producer offers powerful ways to both preview and publish presentations, ensuring that what users see is what the audience will get when viewing the actual presentation. This also reduces much of the “tweaking” required with more traditional tools. To preview the media integration, synchronizations, transitions and effects, and choice of templates (layouts), users can simply click the Preview Presentation tab to see the presentation exactly as it would appear when published.

Publishing a presentation
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Once completed, presentations can be published by using Producer’s Publish Wizard. Business users can publish the presentation to local drives and network shares for local viewing, forwarding to their IT department, or creating their own CDs. The Publish Wizard allows users to specify the playback rates and quality settings for the presentations based on the intended audience and their anticipated connections. 

This feature also opens up new opportunities for independent software vendors and hosting providers. Network administrators, independent software vendors and hosting providers can use the Publishing SDK that ships as part of Producer to develop publishing services that can make it easy for business users to publish their own presentations to the company intranet or the Internet. 

Try it!

1. Using the presentation that you have created to this point, you can now publish it to see how quickly and easily this can be done.

2. To start, simply click on the Publish button in the Toolbar.

3. The Publish Wizard will now appear, offering three choices of publishing destinations. Choose My Computer and click on Next.

4. Enter the name for the presentation as you would like it to appear once published, and also choose the directory path for it.

5. Next, enter or revise the presentation information that will be used in creating the Pre-Roll page.

6. Next, choose the appropriate playback rate based on your intended audience, and click on Next.

7. Now, click on Finish to complete the publishing process.

FrontPage Integration

Users of FrontPage can import presentations created with Producer directly into their FrontPage-based Web pages, providing another easy presentation publishing scenario.

Microsoft Producer Pack and Go

Because a published Producer presentation is essentially a Web site, the Pack and Go feature delivers an easy way to move Producer projects from one computer to another. The Pack and Go feature packs a project into one file, complete with all media files, transitions, effects and the populated timeline. The feature also serves as an effective archive of Producer projects, making it possible to use the Pack and Go file should a content creator wish to go back and change a published rich-media presentation.

Viewing a Producer Presentation

Once a Producer presentation has been published, it can be viewed with any Internet Explorer browser (Internet Explorer 5.0 or later). Specific software requirements to view a presentation are listed in the appendix.

Appendix 1: System Requirements 

The following are the system requirements for running Microsoft Producer:

	Processor
	400 MHz required; 600 MHz Pentium III or equivalent recommended

	Hard drive space
	2 GB required; 20 GB recommended for DV capture of extended video content

	Memory
	128 MB of RAM required

	Sound card
	A sound card is required

	Other hardware
	Audio and video capture devices recommended


The following are the software requirements for running Microsoft Producer:

	Project Creation
	

	Operating system
	Windows 2000 Professional, Windows XP Professional or Windows XP Home Edition with Internet Explorer 5.0 or higher

	Application Suite
	Office XP


The following are the software requirements for viewing rich-media presentations created by Microsoft Producer:

	Presentation Viewing
	

	Web Browser
	Presentations playback in Internet Explorer 5.0 or higher 

	Media Player
	Windows Media Player 6.4 or later required; Windows Media Player 7.0 or later recommended


Appendix 2: Supported Audio and Video Formats

· .avi
Windows video file format

· .wav
Windows audio file format

· .asf
Windows Advanced Streaming Format

· .wm
Windows Media file format

· .wma
Windows Media Audio

· .wmv
Windows Media Video

· .mp3
MPEG-1 layer 3 audio file format

· .mpg
MPEG video file format (also .m1v, .mp2, .mp2v, .mpa, .mpe, .mpeg or .mpv2)

· .aif
Apple audio file format (also .aiff or .aifc)

· .snd
Apple audio file format

· .au
Compressed audio file format
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Producer’s Publish Wizard
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Video transitions in Producer
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Video effects in Producer
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Synchronizing audio, video and slides in Producer
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Sample of a video split into multiple clips
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Producer’s Capture Wizard
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Import dialog box














� EMBED Excel.Chart.8 \s ���











PAGE  

[image: image18.png]Bl Edt Vew Dok Cp Py Hep

DM $BEX o- o | B coptwe @ Sychvaice. £ Pl

&) Media | @ Table of Contents [& Preview Presentation

Train The Interviewer
Section 3 — Investigating Background Issues

»” 0:00:03/0:07:49

Train The Interviewer

Review of Section 2
Investigating Background Issues
Sample Interview Video
Interview Objectives

Thank you

Rebecca Jones
Human Resources Trainer

Shaw Timeline

Ready



_1063187298.xls
Chart1

		Oct. 99

		April 01



Enterprise Adoption Rate

Enterprise Use of Streaming
(Market Decisions Corp Survey of over 700 Organizations in the US)

0.09

0.25



Sheet1

				Oct. 99		Oct. '00		April 01

				9%		20%		25%





Sheet1

		Oct. 99

		April 01



Enterprise Adoption Rate

0.09

0.25



Sheet2

		





Sheet3

		






